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About this document 

Scope and purpose 

This user guide provides an overview of the evaluation board EVAL-M1-IM523 including its main features, key 
data, pin assignments, and mechanical dimensions. 

This evaluation board has been developed to provide initial support to customers in designing motor drive 

applications for major home appliances such as air conditioners, pumps, fans, and other variable-speed drives. 

The EVAL-M1-IM523 is part of the iMOTION™ modular application design kit (MADK). Together with a control 
board equipped with the M1 20-pin interface connector, such as the EVAL-M1-101T, it features and 
demonstrates the Infineon CIPOS™ Mini intelligent power module (IPM) technology and advanced motion 

control engine (MCE 2.0) technology for permanent magnet motor drives. EVAL-M1-IM523 is based on the 
IM523-X6A CIPOS™ Mini IPM. The IM523-X6A is designed to control 3-phase AC motors and permanent magnet 
motors in variable-speed drives. It works with a voltage of 600 V and provides a current rating of 17 A. 

Intended audience 

This user guide is intended for all technical specialists who know motor control and low-power electronic 

converters. The evaluation board is intended to be used under laboratory conditions. 

Evaluation board 

This evaluation board is to be used during the design-in process for evaluating and measuring characteristic 
curves, and for checking datasheet specifications. 

Note: PCB and auxiliary circuits are NOT optimized for final customer design. 

 

 

Figure 1 The iMotionTM MADK evaluation board for IM523-X6A CIPOS™ Mini IPM 
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Important notice 

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board 
(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration, 
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).  

 
Environmental conditions have been considered in the design of the Evaluation Boards and Reference 

Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards 
has been tested by Infineon Technologies only as described in this document. The design is not qualified 
in terms of safety requirements, manufacturing and operation over the entire operating temperature 
range or lifetime. 

 

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional 

testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the 

same procedures as regular products regarding returned material analysis (RMA), process change 
notification (PCN) and product discontinuation (PD). 

 
Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for 

evaluation and testing purposes. In particular, they shall not be used for reliability testing or production. 
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards 

(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other 
requirements of the country in which they are operated by the customer. The customer shall ensure that 

all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant 
requirements and standards of the country in which they are operated. 
 

The Evaluation Boards and Reference Boards as well as the information provided in this document are 

addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and 
managed according to the terms and conditions set forth in this document and in other related 
documentation supplied with the respective Evaluation Board or Reference Board.  

 
It is the responsibility of the customer’s technical departments to evaluate the suitability of the 

Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness 
and correctness of the information provided in this document with respect to such application. 

 
The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not 

cause any harm to persons or third party property.  
The Evaluation Boards and Reference Boards and any information in this document is provided "as is" 
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to 

warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or 

for merchantability.  

 
Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation 

Boards and Reference Boards and/or from any information provided in this document. The customer is 
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or 
damages arising out of or resulting from any use thereof. 

 
Infineon Technologies reserves the right to modify this document and/or any information provided 

herein at any time without further notice. 
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Safety precautions 

Note: Please note the following warnings regarding the hazards associated with development systems. 

Table 1 Safety precautions 

 

Warning: The DC link potential of this board is up to 400 VDC. When measuring voltage 
waveforms by oscilloscope, high voltage differential probes must be used. Failure to do 

so may result in personal injury or death. 

 

Warning: The evaluation or reference board contains DC bus capacitors which take 
time to discharge after removal of the main supply. Before working on the drive 
system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to 

do so may result in personal injury or death. Darkened display LEDs are not an 

indication that capacitors have discharged to safe voltage levels. 

 

Warning: The evaluation or reference board is connected to the grid input during 
testing. Hence, high-voltage differential probes must be used when measuring voltage 

waveforms by oscilloscope. Failure to do so may result in personal injury or death. 

Darkened display LEDs are not an indication that capacitors have discharged to safe 

voltage levels. 

 

Warning: Remove or disconnect power from the drive before you disconnect or 
reconnect wires, or perform maintenance work. Wait five minutes after removing 

power to discharge the bus capacitors. Do not attempt to service the drive until the bus 
capacitors have discharged to zero. Failure to do so may result in personal injury or 

death. 

 

Caution: The heat sink and device surfaces of the evaluation or reference board may 

become hot during testing. Hence, necessary precautions are required while handling 

the board. Failure to comply may cause injury. 

 

Caution: Only personnel familiar with the drive, power electronics and associated 
machinery should plan, install, commission and subsequently service the system. 

Failure to comply may result in personal injury and/or equipment damage. 

 

Caution: The evaluation or reference board contains parts and assemblies sensitive to 

electrostatic discharge (ESD). Electrostatic control precautions are required when 

installing, testing, servicing or repairing the assembly. Component damage may result 
if ESD control procedures are not followed. If you are not familiar with electrostatic 

control procedures, refer to the applicable ESD protection handbooks and guidelines. 

 

Caution: A drive that is incorrectly applied or installed can lead to component damage 

or reduction in product lifetime. Wiring or application errors such as undersizing the 
motor, supplying an incorrect or inadequate AC supply, or excessive ambient 

temperatures may result in system malfunction. 

 

Caution: The evaluation or reference board is shipped with packing materials that 
need to be removed prior to installation. Failure to remove all packing materials that 
are unnecessary for system installation may result in overheating or abnormal 

operating conditions. 
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1 The board at a glance 

The EVAL-M1-IM523 evaluation power board is part of the iMOTION™ modular application design kit for motor 

drives (iMOTION™ MADK). The MADK platform is intended to be used with various power stages and different 
control boards. The EVAL-M1-IM523 can be easily connected to a control board such as the EVAL-M1-101T 
through the 20-pin iMOTION™ MADK M1 connector. The EVAL-M1-101T control board is designed to control a 
single motor. 

The EVAL-M1-IM523 is available through regular Infineon distribution partners and through Infineon’s website. 
This user guide details the features of the evaluation board (Section 1.3 ) and provides information on how 

customers can copy, modify, and qualify the design for production according to their specific requirements.  

Environmental conditions were considered in the design of the EVAL-M1-IM523, but the evaluation board is not 

qualified, in terms of safety requirements, for manufacturing and operation over the entire operating 
temperature range or lifetime. The boards provided by Infineon are subjected to functional testing only. 

The evaluation boards are not subject to the same procedures as regular products regarding returned material 
analysis (RMA), process change notification (PCN), and product discontinuation (PD). Evaluation boards are 
intended to be used under laboratory conditions by technical specialists only. 

1.1 Scope of supply 

The EVAL-M1-IM523 evaluation board is designed to provide an easy-to-use power stage based on Infineon’s 
CIPOS™ Mini intelligent power module (IPM) IM523-X6A.  

The delivery includes the finished evaluation board as shown in Figure 1. It provides a single-phase AC-input 
connector, an EMI filter, an input rectifier, DC bus capacitors, and a 3-phase output to connect the motor. It also 

contains: 

1. A CoolSETTM based auxiliary power supply to provide output of 15 V and 5.0 V 

2. Emitter shunts for current sensing and overcurrent protection 

3. A voltage divider for DC-link voltage measurement 

The evaluation board shown in Figure 1 can be operated directly with the required power supply without 

additional components. 

1.2 Block diagram 

The block diagram of the EVAL-M1-IM523 board is shown in Figure 2. 
 

 

Figure 2 Block diagram of the EVAL-M1-IM523 evaluation board 
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Figure 3 shows the functional groups of the EVAL-M1-IM523 board. 
 

 

Figure 3 The functional groups of the EVAL-M1-IM523 evaluation design 

 

1.3 Main features 

The EVAL-M1-IM523 evaluation board, combined in a kit with one of the available MADK control boards, has the 
following features: 

• Input voltage 85 VAC to 255 VAC 

• PWM frequency 15 kHz and 3 Arms input current at 110 VAC (output power around 500 W) 

• PWM frequency 15 kHz and 5.5 Arms input current at 220 VAC (output power around 900 W) 

• Inrush current limiter for circuit protection 

• On-board EMI filter  

• Auxiliary power supply with 15 V, 5.0 V 

• Overcurrent hardware protection and over-temperature protection 

• Sensing of DC-link voltage 

• Thermistor output 

• Temperature-controlled cooling fan speed adjustment 

• PCB size is 160 mm × 115 mm, two layers with 1 oz. copper 

• RoHS compliant  
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1.4 Board parameters and technical data 

Table 2 lists the important specifications of the EVAL-M1-IM523. 

Table 2 Parameters 

Parameter Symbol Conditions Value Unit 

Input 

Input voltage VAC Lower AC input, less motor power output 85 - 255 Vrms 

Input current  IAC(condition 1) Input 220 VAC , fPWM = 15 kHz, TA = 29°C, 

TC = 90°C, with heat sink 

5.6 Arms 

IAC(condition 2) Input 110 VAC , fPWM = 15 kHz, TA = 29°C, 

TC = 90°C, with heat sink 

3.1 Arms 

Output 

Power (3-phase) 

 

Pout(condition 1) Input 220 VAC , fPWM = 15 kHz, TA = 29°C, 

TC = 90°C, with heat sink  

930 W 

Pout(condition 2) Input 110 VAC , fPWM = 15 kHz, TA = 29°C, 

TC = 90°C, with heat sink 

512 W 

DC bus 

Maximum DC-bus 

voltage 

VDC(max) AC input 255 Vrms 360 V 

Minimum DC-bus 

voltage 

VDC(min) AC input 85 Vrms 125 V 

Current feedback 

Shunt resistance RS1 Leg shunt 10 mΩ 

Protection 

Overcurrent protection IOCP Configured by changing shunt resistors 

RS1 for current sensing 

10.1 1    Apeak 

Auxiliary power supply 

Voltage circuit (VCC) 

voltage output 

VCC Used for IPM power supply 15 ±5% V 

5.0 V voltage output V5.0 V Used for IMC101T controller and 

protection circuits 

5.0 ±5% V 

PCB characteristics 

Dimension  Length × width 160 × 115 Mm 

Material  FR4, 1.6 mm thickness, 1 oz. PCB   
 

                                                                    
1 For iMOTION™ IC IMCxxx, there are three types of gatekill input source options in the MCEWizard setup: gatekill-pin, comparator, and 

both. If you select the “comparator” mode, the external gatekill signal will not be used, and the signals IU+/IV+/IW+ will be compared by 

the internal comparator with the “Device overcurrent trigger level setting” value set in the MCEWizard.  
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2 System and functional description 

2.1 Getting started 

To run the motor system, a combination of iMOTION™ MADK power board (EVAL-M1-IM523) and a matching 
MADK control board (EVAL-M1-101T or other control board) is required. This chapter provides information on 
setting up the system and getting started with the iMOTION™ MADK development platform. 

EVAL-M1-IM523 evaluation boards are tested with EVAL-M1-101T control boards that are shipped with 
embedded firmware and default parameters.  

The following actions must be performed to achieve a usable motor controller IC from a blank IMC101T: 

• Programming the motion control engine (MCE) 

• Programming the parameter sets for system and motor 

• Programming customer scripts (optional) 

• Programming the combined file for an integrated system (optional)  

The iMOTION™ software tools—MCEDesigner and MCEWizard—are required for initial system setup, and to 
control and fine-tune the system performance to match the user’s exact needs. These tools can be downloaded 
from the Infineon website. Please check this page periodically for tool and software updates. 

An iMOTION™ link or an on-board USB-to-UART cable is needed to bridge the PC/debugger side and the motor 

drive system (on the target iMOTION™ device, hot side) with a 1 kV DC galvanic isolation. 

Figure 4 shows the basic system connection using the EVAL-M1-IM523 board to run a 3000 W GK6036 motor with 
MCEDesigner. Refer to the MCEWizard and MCEDesigner documentation for more information. 

 

Figure 4 Example of the system connection 

AC input 

Control board UVW phase output 

DC bus test 

ground 

https://www.infineon.com/cms/en/product/power/motor-control-ics/digital-motor-controller-imotion/imc101t-t038/#!tools
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Figure 5 MCEWizard’s welcome page 

After downloading and installing the MCEWizard and MCEDesigner, follow these steps to run the motor: 

1. Connect the EVAL-M1-101T control board to the EVAL-M1-IM523 evaluation board. Then, connect the PC-
USB connector to the EVAL-M1-101T control board. 

2. Connect the 220 V AC power supply and the UVW outputs to the motor. 

3. In the MCEWizard, enter the system and operating parameters of the target motor, and the hardware 
parameters of the evaluation board. This data is used for calculating the digital parameter set of the 

controller, representing the complete motor drive system.  

4. After setting the system and operating parameters, go to the Verify & Save page and click Calculate 

Parameters. If no errors are reported, save the drive parameter set into your project directory by clicking 

Export to MCEDesigner file (.txt) (see Figure 6); if an error message appears, double-click the error 
message (highlighted in RED) and adjust the erroneous parameters. This drive-system parameter file is later 

used by the MCEDesigner (step 9.)  

Note: Refer to the MCEWizard_V2.3.0.1 User Guide.pdf for details. This guide is available in the MCE 
Wizard’s installation path.  
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Figure 6 MCEWizard’s Verify & Save page 

5. Turn on the 220 V AC power supply, LED 1 and 2 turn red. 

6. Start the MCEDesigner tool and click File > Open to open the MCEDesigner default configuration file (.irc) for 

the IMC101T device (IMC101T_Vxxx.irc.)  

(The IMC101T_Vxxx.irc file is included in the downloaded IMC101T MCE software package). 

7. The MCEDesigner should automatically connect to the EVAL-M1-101T board using the default COM port 
(indicated by a green circle next to the “COMx Up” status in the bottom frame of the MCEDesigner GUI). If 

the connection cannot be established due to an incorrect COM port, change the COM port by following 

these steps: 

a) Open the System Page window. 

b) Click Preferences > Connection > Connect using. 

c) Choose one of the other available COM ports from the drop-down list. 

8. In case of a blank IC: If the firmware has been erased from the IMC101T, a warning message will pop up (see 

Figure 7) “Target device firmware and parameters files are not programmed! Please program firmware and 

parameters file.” See step 9 on how to obtain/program firmware and parameters. 
 

 

Figure 7 MCEDesigner warning message 
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9. In case of a blank IC: To program the firmware and the parameters file into the internal Flash memory of the 

iMOTION™ Control IC, follow these steps: 

a) Open the System Page. 

b) Click Tools > Programmer and select Program Firmware and Parameters, as shown in Figure 8. 

c) The encrypted firmware is available in the IMC101T MCE Software Package. For the parameters file, 
browse and select the .txt file generated in step 4.    

d) If the IMC101T IC is blank, the MCEDesigner will generate the pop-up message“Target device 
firmware and parameter files are not programmed!” 

e) Program the MCE firmware and system parameters into the internal Flash memory of the iMOTION™ 
IC by selecting Tools > Programmer from the pull-down menu, and then selecting the Program 
Firmware and Parameter check box. 

f) Select the right parameter file and firmware file. 

g) Click Start to program the firmware and parameter.  

h) Click YES and then OK to update the IRC file with the parameter file. 

i) Click Save As to save the IRC file with a file name that contains the COM config, parameters, and 
firmware file path information. 

Note: Refer to the MCEDesigner User Guide.pdf and the MCEDesigner_V2.3.0.1 Application Guide.pdf 
(available in MCEDesigner’s install path) for details. 

After the programming is complete, the red LED1 on EVAL-M1-101T will flash on. 
 

 

Figure 8 MCEDesigner’s program page 

10. Double-click the VF Diagnostic function in the motor1 page and monitor the motor current with an 
oscilloscope. If the motor current is not sinusoidal, change the target speed and Vd_Ext in VF Diagnostic 
sub-function, then double-click VF Diagnostic again. Repeat until the oscilloscope shows a steady 

sinusoidal current with an amplitude that is 30–50% of the motor rate current. 

11. Open System Page > Monitor Definitions and double-click Iu & Iv_Slow. The motor current feedback should 
be clean and sinusoidal, as shown in Figure 9. If not, please tune the Gating Propagation Delay & Phase Shift 

Window Size in the MCEWizard. The sampled motor-current noise amplitude should be less than 50–100 
counts (below 5% of the motor current or below 5% of the maximum AD (analog to digital converter) range, 

which is 2048 counts.) If not, the motor current sample-related hardware and the setup need tuning. 
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The VF Diagnostic sub-function can verify whether the: 

o Motor is correctly connected  

o IGBT/MOS and gate driver work as expected 

o Parameters related to current-sensing are correctly configured 

o PCB layout and DC bus decoupling have been done correctly 

12. After the VF Diagnostic is complete, click STOP (the red traffic light button) to stop the PWM (Pulse Width 

Modulation). 
 

 

Figure 9 Trace waveform for Iu & Iv open loop diagnostic 

13. Click the green traffic light button in the control bar to start the motor or double-click Start Motor sub-
function in the Motor1 page “group of User Application Function Definitions.” The motor runs when this 
step functions properly. 

14. Check the motor-spin direction, adjust the UVW connection order, or set negative target speed in the 

MCEDesigner if the direction is wrong. 

15. Set the target speed to about 50% of the maximum speed and start the Iu & Flx_M trace with Auto Repeat on 

Level Mode (see Figure 10.) Flx_M is better within the range of 2000 to 2500 (rated value is 2048), and must 
be steady and DC-like.  

Some key tips for better motor-performance tuning are: 

• If Flx_M is not steady (i.e. swinging or oscillating), double-check the motor parameters, speed loop 

Propotional-Intergra (PI) gain, flux estimator time constant, and the setup related to the PLL PI 
bandwidth (parameters PLLKp and PLLKi).  

• If Flx_M is noisy, double-check the current feedback, and the hardware and parameters related to VDC. 

• If Flx_M is far from 2048, adjust the Motor Back EMF Constant (Ke) in the MCEWizard. 
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Figure 10 Trace waveform for Iu & Flx-M at 50% speed 

16.  To program a new parameter file after the firmware has been programmed, follow the instructions given in 
Step 9. In such cases, firmware programming is not needed. 

Note: For detailed information on controller programming, refer to the Application Note AN2018-33 
iMOTION™ 2.0 Device Programming, and the documentation for the MCEDesigner and MCEWizard. 

2.2 Description of functional blocks 

The motor inverter in the EVAL-M1-IM523 evaluation design is implemented using the CIPOS™ Mini IPM IM523-
X6A, and the auxiliary power supply is based on the fixed-frequency CoolSETTM ICE5GR4780AG. 

The CIPOSTM Mini IPM IM523 product group enables the integration of various power and control components 

to increase reliability, optimize PCB size, and reduce system costs. It is designed to control 3-phase AC motors 
and permanent-magnet motors in variable speed drives for applications such as air conditioners and 
refrigerators.  

The package concept is especially adapted to power applications that need good thermal conduction, 

electrical isolation, EMI control, and overload protection. The integrated reverse-conducting IGBTs are 

combined with an optimized silicon on insulator (SOI) gate driver for excellent electrical performance. 

Figure 11 shows the internal block diagram of the CIPOS™ Mini IPM IM523-X6A.  

Its main features include: 

• A 600 V reverse-conducting RCD2 IGBT 
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• A rugged SOI gate driver technology with stability against transient and negative voltage 

• An allowable negative VS potential up to -11 V for signal transmission at VBS = 15 V 

• An integrated bootstrap functionality 

• An overcurrent shutdown mechanism 

• A built-in NTC thermistor for temperature monitoring 

• Undervoltage lockout at all channels 

• Low-side emitter pins accessible for phase-current monitoring (open emitter) 

• A sleep function 

• Cross-conduction prevention 

• All six switches turn off during protection 
 

 

Figure 11 Internal block of the IM523-X6A 
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3 System design    

The EVAL-M1-IM523 board is an optimized design for 220 V small home appliances like air conditioners, pumps, 
and fan applications. To meet individual customer requirements, and to make the EVAL-M1-IM523 evaluation 
design a basis for development or modification, all board design data such as schematics, Gerber, and AD files 

can be found on Infineon’s website. 

3.1 EMI filter and soft power-up circuit 

Figure 12 shows the schematic from the AC input connector X1 to the rectified DC bus voltage. This circuitry 
includes a passive EMI filter consisting of elements X, Y capacitors and common-mode inductor, a 10 A/600 V 

rectifier bridge D3 (GBJ1006-BP), an F1 fuse for circuit protection, a PTC resistor, and an RY1 relay for soft 

power-up and reduction of conduction losses in steady state. 
 

 

Figure 12 Schematics for EMI filter and a soft power-up circuit 

3.2 Inverter section using CIPOS™ Mini IPM 

The inverter section is implemented using the CIPOS™ Mini IPM as shown in Figure 13. The module includes a 
combination of an optimized reverse-conducting IGBT Gen 2 (RCD2), and industry-benchmark, robust half-
bridge drivers. The shunt resistor section is also provided in the inverter section, including 10 mΩ RS1 resistors. 
The overcurrent level can be set up by using an OPAMP. The three capacitors C3, C6, and C8 are used as 

bootstrap capacitors to provide the necessary floating supply voltages VBS1, VBS2, and VBS3, respectively. 
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Figure 13 Schematics for the IM523-X6A IPM and peripheral circuit 

3.3 Auxiliary power supply 

Figure 14 shows the schematic of the auxiliary power supply for the EVAL-M1-IM523 board. The circuit includes 

the latest CoolSETTM 5 (ICE5GR4780AG) from Infineon and a flyback topology with direct output of 15 V and 6 V. 

The VCC is connected to the gate drivers inside the CIPOS™ IPM. 
 

 

Figure 14 Auxiliary power supply of the EVAL-M1-IM523 

The linear voltage regulator TLE42744DV50 generates 5.0 V from a 6 V power supply VCC. The 5.0 V power 

supply is used in the inverter’s external overcurrent comparator circuit. Both VCC and 5.0 V are also present on 
the 20-pin iMOTION™ MADK-M1 interface connector to power the circuitry on the control board. 



  

 17 Revision 1.00  

  2023-01-16 

EVAL-M1-IM523 user guide 
iMotionTM modular application design kit 

  

System design 

 
3.4 Layout 

The EVAL-M1-IM523 board has two electrical layers with 140 µm copper (1 oz.) and a dimension of 160 mm x 115 
mm. The thickness of the PCB board is 1.6 mm. Figure 15 and Figure 16 show the PCBA assembly of the EVAL-

M1-IM523.    
 

 

Figure 15 Top-assembly PCBA of the EVAL-M1-IM523 
 

 

Figure 16 Bottom-assembly PCBA of the EVAL-M1-IM523 
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3.5 Bill of material  

The complete bill of material can be downloaded (a customer login is required) from the Download section on 
the homepage of Infineon’s website.  

Table 3 BOM of the most important/critical parts of the evaluation board 

Quantity Ref Designator Description Manufacturer Manufacturer P/N 

7 C1, C4, C5, C7, C9, 
C20, C25 Chip Monolithic Ceramic Capacitor MuRata GRM31CR71E106MA12 

1 C2 Chip Monolithic Ceramic Capacitor MuRata GCM188R71E472JA37 

7 C3, C6, C8, C28, 
C37, C40, C56 

Chip Monolithic Ceramic Capacitor, CAP / 
CERA / 100nF/ 50V/ 10%/ X7R (EIA)/ -

55℃ to 125℃/ 603(1608)/ SMD 
MuRata, AVX GRM188R61E104KA01, 

06035C104K4Z2A 

2 C10, C12 

CAP / FILM / 1uF / 630V / 10% / MKT 

(Metallized Polyester) / -40℃ to 105℃ / 

22.50mm C X 0.80mm W 26.00mm L X 
11.00mm T X 20.50mm H / THT / - 

Wurth Elektronik 890324026027CS 

2 C11, C13 

CAP / CERA / 2.2nF / 1kV / 20% / Y5U 

(EIA) / -40℃ to 125℃ / 5.00mm C X 

0.60mm W 9.00mm L X 5.00mm T X 
13.00mm H / THT / - 

Vishay VY2222M35Y5US6TV5 

12 
C14, C15, C16, C17, 
C18, C19, C22, C26, 
C29, C30, C52, C53 

Chip Monolithic Ceramic Capacitor, CAP / 
CERA / 1nF / 25V / 5% / C0G (EIA) / NP0 / 

-55℃ to 125℃ / 0603(1608) / SMD 
MuRata GRM188R71E102JA01, 

GRM1885C1E102JA01 

2 C21, C27 Chip Monolithic Ceramic Capacitor MuRata GRM1885C1H220JA01 
1 C23 MLCC Chip Capacitor, SMD TDK Corporation C3216X5R1E226M160AB 
1 C24 Chip Monolithic Ceramic Capacitor MuRata GRM188R71H471KA01 

2 C31, C32 

CAP / ELCO / 470uF / 400V / 20% / 

Aluminiumelectrolytic / -25℃ to 85℃/ 

10.00mm C X 1.50mm W 35.00mm Dia X 
37.00mm H / - / - 

Wurth Elektronik 861221386021' 

4 C33, C34, C35, C43 
Chip Monolithic Ceramic Capacitor, CAP / 
CERA / 10nF / 50V / 10% / X7R (EIA) / -

55℃ to 125℃ / 0603 / SMD / - 
MuRata, AVX GRM188R71C103KA01, 

06035C103K4Z2A 

1 C36 

CAP / FILM / 470nF / 630V / 5% / MKP 

(Metallized Polypropylene) / -40℃ to 105℃ 

/ 22.50mm C X 0.80mm W 26.00mm L X 
9.00mm T X 19.00mm H / THT / - 

Wurth Elektronik 890303326009CS 

2 C38, C39 

CAP / ELCO / 330uF / 25V / 20% / 

Aluminiumelectrolytic / -40℃ to 85℃ / 

3.50mm C X 0.60mm W 8.00mm Dia X 
13.00mm H / THT / - 

Wurth Elektronik 860010474012' 

1 C41 
CAP / CERA / 100nF / 630V / 10% / X7R 

(EIA) / -55℃ to 125℃ / 1812 / SMD / - Wurth Elektronik 8.85342E+11 

1 C42 
CAP / CERA / 1nF / 630V / 10% / X7R 

(EIA) / -55℃ to 125℃ / 1206(3216) / SMD MuRata GRM31BR72J102KW01 

1 C44 
CAP / CERA / 100nF / 50V / 10% / X7R 

(EIA) / -55℃ to 125℃ / 0603 / SMD / - AVX 06035C104KAT2A 

1 C45 

CAP / ELCO / 220uF / 16V / 20% / 

Aluminiumelectrolytic / -40℃ to 85℃ / 

2.50mm C X 0.50mm W 6.30mm Dia X 
12.50mm H / THT / - 

Wurth Elektronik 860010373010' 

1 C46 
CAP / CERA / 10uF / 16V / 10% / X5R 

(EIA) / -55℃ to 85℃ / 0805(2012) / SMD  MuRata GRM219R61C106KA73 

1 C47 

CAP / ELCO / 100uF / 16V / 20% / 

Aluminiumelectrolytic / -40℃ to 85℃ / 

2.00mm C X 0.50mm W 5.00mm Dia X 
12.50mm H / THT / - 

Wurth Elektronik 860010473007' 
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1 C48 

CAP / ELCO / 100uF / 35V / 20% / 

Aluminiumelectrolytic / -40℃ to 85℃ / 

2.50mm C X 0.50mm W 6.30mm Dia X 
12.50mm H / - / - 

Wurth Elektronik 860010573007' 

1 C49 

CAP / CERA / 1nF /  / 20% / E (JIS) / -40℃ 

to 125℃ / 7.50mm C X 0.60mm W 

7.00mm L X 7.00mm T X 10.00mm H / 
THT / - 

MuRata DE6E3KJ102MN3A 

2 C50, C57 
CAP / CERA / 1nF / 16V / 10% / X7R (EIA) 

/ -55℃ to 125℃ / 0603(1608) / SMD Kemet C0603C102K4RACTU, 
C0603C102F5GAC 

1 C51 
CAP / CERA / 220nF / 25V / 10% / X5R 

(EIA) / -55℃ to 85℃ / 0603(1608) / SMD  MuRata GRM188R61E224KA88 

1 C54 
CAP / CERA / 2.2nF / 50V / 10% / X5R 

(EIA) / -55℃ to 85℃ / 0603(1608) / SMD MuRata GRM188R61H222KA01 

1 C55 

CAP / ELCO / 47uF / 25V / 20% / 

Aluminiumelectrolytic / -40℃ to 105℃ / 

2.00mm C X 0.50mm W 5.00mm Dia X 
12.50mm H / THT / - 

Wurth Elektronik 860020472006' 

4 D1, D2, D4, D5 Surface Mount Fast Switching Diode Diodes Incorporated 1N4148W-7-F 

1 D3 Glass Passivated Bridge Rectifier 600V Micro Commercial 
Components GBJ1006-BP 

1 D6 High Voltage Surface-Mount Schottky 
Rectifier, VRRM 100V Vishay SS2H10-E3/52T 

1 D7 Surface Mount Ultrafast Rectifier 
1.0A/1000V Vishay US1M-E3/61T 

1 D8 Surface-Mount Schottky Barrier Rectifier, 
VRRM 45V Vishay BYS10-45-E3/TR3 

1 D9 Super Fast Recovery Diode, VR 200 V, IF 
1 A 

ROHM 
Semiconductors RF071MM2STR 

1 D10 Zener Diode, 5% 13V Solid State Devices 
Inc. SZ25B13SM 

1 F1 FUSE CERAMIC 12.5A 250VAC 
125VDC,5x20mm Schurter 0001.2715.11 

1 Fan 
DC Axial Fan for omniCOOL bearing 
system,50 x 50 mm frame. Mulitple Speed 
options 

CUI CFM-5015V-138-201 

1 Fuse1 Fuse Holder Block, PCB Clip Cover, 18A, 
250VAC Wurth Elektronik 696101000002' 

2 J1, J2 Horizontal Cable Entry with Rising Cage 
Clamp - WR-TBL, 3Pins Wurth Elektronik 691216510003S 

1 J3 Header, 2.54mm Pitch, 2 pin, Vertical, 
Single Row Wurth Elektronik 61300211121 

1 L1 

IND / STD / 12mH / 10A / 50% / -40℃ to 

125℃ / 15mR / THT / Inductor, THT, 4 pin, 

23.00 mm L X 34.00 mm W X 33.00 mm H 
body / THT / - 

Wurth Elektronik 7448051012 

1 L2 

IND / STD / 2.2uH / 2.5A / 20% / -40℃ to 

125℃ / 71mR / SMD / Inductor, SMD; 2-

Leads, 4.50 mm L X 4 mm W X 3.50 mm H 
body / SMD / - 

Wurth Elektronik 744773022 

1 LED1 LED 3mm Red Through Hole Lamp LiteOn 
Optoelectronics LTL-1CHEE 

1 MP1 Standard Heatsink Infineon Technologies HS-5050-100 

3 MP2, MP3, MP4 M3 Metric Countersunk Head Screw, 
Length 10mm Duratool M310 KRSTMCZ100- 

4 MP5, MP6, MP7, 
MP8 Pan Head Screw, M3X0.5 Keystone Electronics 

Corp. 9191-4 

4 MP9, MP10, MP11, 
MP12 WA-SSTIE Steel Spacer Stud, M3 Wurth Elektronik 971060321 
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4 MP13, MP14, MP15, 
MP16 

3M Bumpon Protective Product SJ61A1 is 
a self-adhesive rubber bumper 3M SJ61A1 

1 PTC1 PTC thermistor for overcurrent protection 
and as inrush current limiters TDK Corporation B59451C1130B070 

1 Q1 30V 154mOhm@4.5V MOSFET Infineon Technologies IRLML2030TRPbF 
1 Q2 NPN Silicon Switching Transistor Infineon Technologies SMBT3904 
2 R1, R2 Standard Thick Film Chip Resistor Vishay CRCW1206680KFK 

6 R3, R4, R5, R6, R7, 
R8 General Purpose Chip Resistor Yageo RC0603FR-07220RL 

2 R9, R10 330k/500V/5% Vishay PR02000203303JR500 

1 R11 
RES / STD / 51R / 500mW / 1% / 

100ppm/K / -55℃ to 155℃ / 1210 / SMD Vishay CRCW121051R0FK 

2 R12, R56 
Standard Thick Film Chip Resistor, RES / 
STD / 47k / 100mW / 1% / 100ppm/K / -

55℃ to 155℃ / 0603(1608) / SMD / - 
Vishay CRCW060347K0FK 

1 R13 Standard Thick Film Chip Resistor Vishay CRCW060320K0FK 
2 R14, R26 Standard Thick Film Chip Resistor Vishay CRCW0603220KFK 
1 R15 General Purpose Chip Resistor Yageo RC0603FR-07100RL 
1 R28 General Purpose Chip Resistor Yageo RC0603FR-07100RL 

5 R16, R17, R25, R29, 
R30 General Purpose Chip Resistor Yageo RC0603FR-074K7L 

5 R18, R19, R20, R23, 
R24 Standard Thick Film Chip Resistor Vishay CRCW06031K00FK 

1 R21 Standard Thick Film Chip Resistor Vishay CRCW06034K53FK 
1 R22 Standard Thick Film Chip Resistor Vishay CRCW06034K53FK 
1 R27 General Purpose Chip Resistor Yageo RC0603FR-0722KL 

2 R31, R33 16k/50V/1% ROHM 
Semiconductors MCR03EZPFX1602 

2 R32, R51 
General Purpose Chip Resistor, RES / 
STD / 10k / 100mW / 1% / 100ppm/K / -

55℃ to 155℃ / 0603 / SMD / - 
Yageo RC0603FR-0710KL 

3 R34, R37, R39 
RES / STD / 3MEG / 250mW / 1% / 

100ppm/K / -55℃ to 155℃ / 1206 / SMD Vishay CRCW12063M00FK 

3 R35, R38, R40 
RES / STD / 15MEG / 250mW / 5% / 

200ppm/K / -55℃ to 155℃ / 1206 / SMD Yageo RC1206JR-0715ML 

1 R36 
RES / STD / 68k / 250mW / 1% / 

100ppm/K / -55℃ to 155℃ / 1206 / SMD Vishay CRCW120668K0FK 

1 R41 
RES / STD / 62k / 100mW / 1% / 

100ppm/K / -55℃ to 155℃ / 0603 / SMD Vishay CRCW060362K0FK 

1 R42 
RES / STD / 0R / 100mW / 0R / 0ppm/K / -

55℃ to 155℃ / 0603 / SMD Yageo RC0603JR-070RL 

1 R50 
RES / STD / 0R / 100mW / 0R / 0ppm/K / -

55℃ to 155℃ / 0603 / SMD Yageo RC0603JR-070RL 

1 R43 
RES / STD / 1.5k / 100mW / 1% / 

100ppm/K / -55℃ to 155℃ / 0603 / SMD Yageo RC0603FR-071K5L 

1 R44 
RES / STD / 48.7k / 100mW / 1% / 

100ppm/K / -55℃ to 155℃ / 0603 / SMD Vishay CRCW060348K7FK 

1 R45 
RES / STD / 22k / 100mW / 1% / 

100ppm/K / -55℃ to 155℃ / 0603 / SMD Vishay CRCW060322K0FK 

1 R46 
RES / STD / 510k / 100mW / 1% / 

100ppm/K / -55℃ to 155℃ / 0603 / SMD Vishay CRCW0603510KFK 

1 R47 
RES / STD / 820R / 100mW / 1% / 

100ppm/K / -55℃ to 155℃ / 0603 / SMD Vishay CRCW0603820RFK 

1 R48 
RES / STD / 4.7R / 250mW / 1% / 

100ppm/K / -55℃ to 155℃ / 1206 / SMD Vishay CRCW12064R70FK 
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1 R49 
RES / STD / 9.76k / 100mW / 1% / 

100ppm/K / -55℃ to 155℃ / 0603 / SMD Vishay CRCW06039K76FK 

2 R52, R53 
RES / STD / 2k / 100mW / 1% / 100ppm/K 

/ -55℃ to 155℃ / 0603(1608) / SMD Vishay CRCW06032K00FK 

1 R54 
RES / STD / 9.1k / 100mW / 1% / 

100ppm/K / -55℃ to 155℃ / 0603(1608) / 

SMD 
Vishay CRCW06039K10FK 

1 R55 
RES / STD / 1k / 100mW / 1% / 100ppm/K 

/ -55℃ to 155℃ / 0603(1608) / SMD Yageo RC0603FR-071KL 

1 R57 
RES / STD / 390k / 100mW / 1% / 

100ppm/K / -55℃ to 155℃ / 0603(1608) / 

SMD / - 
Vishay CRCW0603390KFK 

1 RS1 
RES / STD / 10mR / 3W / 1% / 50ppm/K / -

55℃ to 170℃ / 2512(6332) / SMD / - Bourns CRA2512-FZ-R010ELF 

2 RS2, RS3 
RES / STD / 5.1R / 250mW / 1% / 

100ppm/K / -55℃ to 155℃ / 1206 / SMD / - Vishay CRCW12065R10FK 

1 RY1 RELAY GENRAL PURPOSE SPST 20A 
12V Omron G4A-1A-PE 12VDC 

1 TR1 Flyback Transformer, Offline aux SMPS for 
server, PC power applications Wurth Elektronik 750344226 

1 U1 CIPOS Mini IM523 Infineon Technologies IM523-X6A 
1 U2 Dual Comparators Texas Instruments LM393ADR 

1 U3 11MHz, Rail-to-Rail I/O CMOS Operational 
Amplifiers - SGM721XN5/TR 

1 U4 Low Dropout Linear Voltage Regulator, 5.0 
V Output Infineon Technologies TLE42744DV50 

1 U5 
Optocoupler, Phototransistor Output, High 

Reliability, 5300 VRMS, 110℃ Rated Vishay SFH617A-3X007T 

1 U6 Fixed Frequency 700 V/800 V CoolSET, 
lowest standby power <100 mW Infineon Technologies ICE5GR4780AG 

1 U7 Precision Programmable Reference Texas Instruments TL431CDBZR 
1 U8 Low-Power Single Voltage Comparator STMicroelectronics TS391RIYLT 

6 X1, X2, X3, X4, X5, 
X6 Test Point THT, Yellow Keystone Electronics 

Corp. 5004 

1 X7 WR-PHD 2.54 mm Angled Dual Socket 
Header Wurth Elektronik 613020243121' 

3 X8, X9, X10 Test Point THT, White Keystone Electronics 
Corp. 5002 

7 X11, X12, X14, X15, 
X16, X17, X19 Test Point THT, Orange Keystone Electronics 

Corp. 5003 

5 X13, X20, X21, X22, 
X23 Test Point THT, Black Keystone Electronics 

Corp. 5001 

1 X18 Horizontal Cable Entry with Rising Cage 
Clamp - WR-TBL, 2 Pins Wurth Elektronik 691216510002S 

1 ZD1 Zener Diode with Surge Current 
Specification Vishay BZD27C22P-HE3-08 
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4 System performance 

4.1 Auxiliary power supply & inrush current test 

Table 4 Table 1 Auxiliary power supply voltage and inrush current test 

Specification 15 V: 15±0.5 V; 5 V: 5 V±5%; inrush current <10 Apeak; 

Condition Inrush tested at the 25℃ ambient temperature. 

Conclusion ⚫ 15 V & 5 V power supply are within 85~255 VAC input range.  

⚫  The maximum inrush current is 6.8 Apeak at 255 VAC input.  

⚫ The 5 V build-up is 5.4 ms after 15 V build-up. 

⚫ The auxiliary power supply browns in at minimal 50 VAC input 

⚫ The auxiliary power supply browns out at 31 V, VDC_BUS voltage. (Figure 18) 

 

Test Data 

Input voltage 

(Vrms) 

Inrush line 

current 

Max.  

(Apeak-peak) 

Bus caps 

charge 

time 

(ms) 
(power-on 
to relay 

close) 

15 V 

build-up 

time 

(ms) 
(power-on 
to 15 V 

build-up) 

Vdc_BUS 

(V) 

+15 V 

(V) 

+5 V 

(V) 

Test 

waveform 

85 3.653 1233 421 125 14.861 4.987 Figure 19 

220 10.966 1170 373 314 14.865 4.987 Figure 20 

255 13.602 1162 362 360 14.860 4.986 Figure 21 

Legend CH1: 15 V, CH2: 5 V, CH3: Vdc_BUS, CH4: Line current 
 

 

Figure 17 Power supply voltage (15 V & 5 V) 
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Figure 18 Auxiliary power supply browns out 

 

Figure 19 Input 85 VAC 

 

Figure 20 Input 220 VAC 
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Figure 21 Input 255 VAC 

4.2 VDC bus capacitors and VDC ripple 

Table 5 VDC bus capacitors and VDC ripple 

Specification VDC_Bus voltage ripple ratio is less than 10%. 

Condition Tested the VDC bus voltage ripple at the 220 VAC input and 5.5 Arms phase current. fpwm=15 
kHz; 110 VAC input tested at the conditions 500 W output power, 15 kHz PWM and 3 Arms 

phase current. 

Conclusion ⚫ The VDC bus voltage ripple ratio is 4.93% ((28.5/2)/289=0.0493=4.93%) at 220 VAC input 

and 5.5 Arms phase current output. 

⚫ 110 VAC input, VDC bus voltage ripple ratio is 9.17% ((25.5/2)/139=0.0917=9.17%). 

Test Data 

Input voltage 

(V) 

Input 

power (W) 

Phase 

current 

(Arms) 

VDC_bus 

(V) 

VDC_bus ripple 

(Vpeak-peak) 

Ripple ratio 

(%) 
Picture 

220 VAC 930 5.597 289 28.5 4.93 Figure 22 

110 VAC 512 3.125 139 25.5 9.17 Figure 23 

Legend CH1: IAC, CH2: VDCBUS, CH3: IU, CH4: VAC    
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Figure 22 220 VAC input, VDC bus voltage ripple 
 

 

Figure 23 110 VAC input, VDC bus voltage ripple 
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4.3 Current output capability and thermal test 

Table 6 Phase current and IPM case temperature at different PWM and load 

Specification  PWM:4-20 kHz; IPM max. case temperature: about 100℃ ; input voltage range: 

110~230 VAC; Ta: room temperature; 

The output power is 900 W (5.5 Arms) at 220 VAC input and 15 kHz PWM. The output 

power is up to 500 W when the input voltage is 110 VAC. 

Data 

Input 

voltage (V) 

PWM 

(kHz) 
VDC_bus 

(V) 

Input 

power 

 (A) 

Phase 

current 

(Arms) 

Ta 

(℃) 

IPM case 

temperature 

(℃) 

∆T(℃) Picture 

220 4 299.3 369 2.136 22.6 55.6 33  

220 4 297.4 517 3.257 23.4 71.5 48.1  

220 4 294.3 666 4.061 23.8 78.1 54.3  

220 4 290.8 917 5.552 24 85.8 61.8  

220 6 294.7 343 2.2 22.6 57.9 35.3  

220 6 293.4 498 3.095 21.4 72.8 51.4  

220 6 289.8 680 4.137 22.2 79.2 57  

220 6 286.6 921 5.504 22.7 86 63.3  

220 10 298.2 356 2.198 21.2 59.1 37.9  

220 10 295.5 500 3.073 21.9 74.4 52.5  

220 10 293.5 670 4.053 22.6 80.2 57.6  

220 10 288.2 934 5.56 22.7 88.4 65.7  

220 15 298.9 365 2.23 21.6 63.9 42.3  

220 15 297.1 488 2.987 21.7 75.1 53.4  

220 15 292.4 663 4.017 22.7 82.4 59.7  

220 15 289.3 937 5.57 23.4 91.9 68.5 
Figure 27, 

Figure 28 

220 20 295 338 2.065 22.5 66 43.5  

220 20 291.7 493 3.009 22.8 77.6 54.8  

220 20 293.2 669 4.037 23.4 86.3 62.9  

220 20 290.3 931 5.512 23.8 97.1 73.3  

110 15 141.8 330 2.058 22.6 63 40.4  

110 15 139.6 455 2.818 23 72.2 49.2  

110 15 139 512 3.125 23 74.5 51.5 Figure 29 

Legend CH1: VDC; Ch3: VAC; CH4: phase current 

Condition ⚫ With external amplifier for iMOTION controller current sensing input 

Results ⚫ The board works well: 

− with 937 W input power at 220 VAC input and 15 kHz PWM 

− for the 4 to 20 kHz PWM range 

− up to 500 W (3 Arms) output power at the 110 VAC input due to higher bus voltage ripple 

and higher input line current 
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Figure 24  IPM ΔTc Vs. motor phase current at different PWM  

 

Figure 25 Iu & Flx_M at 15 kHz PWM, 220 VAC input, 900 W output (5.5 Arms phase current)  
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Figure 26 Iu & Flx_M at 15 kHz PWM, 220 VAC input, 900 W output (5.5 Arms phase current)  

 

Figure 27 Thermal test at 220 VAC input, 15 kHz PWM and 900 W output                           
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Figure 28 Scope waveform at 220 VAC input, 15 kHz PWM and 900 W output  
 

Figure 29

 

Figure 29 Scope waveform at 110 VAC input, 500 W output power, and 15 kHz PWM  

 

  



  

 30 Revision 1.00  

  2023-01-16 

EVAL-M1-IM523 user guide 
iMotionTM modular application design kit 

  

System performance 

 
4.4 Overvoltage & undervoltage protection 

Table 7 Overvoltage & undervoltage protection 

Specification The overvoltage & undervoltage (OV/UV) protection threshold are set at OV=340 V(2697 
counts); UV=100 V(793 counts). The system can be shut down when the DC bus voltage is 

over/under the threshold (±3 V); voltage scaling is 7.93 cnts/V. 

Data 

Operation Threshold Test results Figures  

OV protection 340 V (2697 counts) 2699.4 counts Figure 30 

UV protection 100 V (793 counts) 793.6 counts Figure 31 

Legend CH1: Iu; Ch2: Vdc 

Condition The fault flag was 1 and reported OV/UV faults on the MCEDesigner when the VDC bus voltage 
reached the OV/UV threshold. 

Result OV/UV protection is in working order. The system is stopped when OV/UV fault appears. 
 

 

Figure 30 OV protection 
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Figure 31 UV protection  
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4.5 Over-temperature protection (OTP) test 

Table 8 Over-temperature 

Specification Over-temperaute threshold voltage is set at 3.4 V in MCEWizard and in the comparator on the 

board. The 3.4 V threshold value corresponds to 105±3℃ IPM case temperature. 

Data 

Operation Phenomenon Picture 

iMOTION solftware OTP 
The motor stopped and over-temperatue fault reported 
in MCEDesigner bottom window. 

Figure 32 

On board hardware OTP 
The motor stopped and the Gatekill was activated and 

the signal goes down. 
Figure 33 

Legend CH1: VFO pin voltage; CH2: Gatekill; CH4: phase current. 

Condition ⚫ OTP threshold was set at 3.4 V, the board ran for 20~30 mintues at 220 VAC input, 650 W 

power and 15 kHz PWM. The forced air-cooled fan was stopped during the test. 

Result ⚫ Both OTP software and hardware worked well. The system stopped as expected. 

 

Figure 32 Solftware over-temperature protection  

 

Figure 33 Hardware over-temperature protection  
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4.6 Overcurrent test 

Table 9 Overcurrent 

Specification Verify the software and hardware overcurrent protection (OCP) function. 

Data 

Operation Phenomenon Picture 

Software OCP 
The motor stopped at 4.21 Apeak phase current and 
reported overcurrent fault in MCEDesigner fault flag. 

Figure 34 

Hardware OCP 
The OCP threshold was set at 9 A, the comparator 
triggered at 10.1 A 

Figure 35 

Legend Figure 34: (CH1:  Vdc; CH3: VAC; CH4: phase current) 

Figure 35: (CH1: Gatekill; CH2: Vge(on); CH3: Itrip; CH4: phase current) 

Condition ⚫ Software OCP: set at 4 A OCP threshold in MCEWizard. 

⚫ Hardware OCP: used a double-pulse tester to create a high-current cross on the shunt 

resistor. 

Result ⚫ OCP functions well. The system stopped as expected. 

 

 

Figure 34 Software OCP  

 

 

Figure 35 Hardware OCP  
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4.7 Direct current feedback test 

Table 10 Direct current feedback test 

Specification Do not use the external amplifier on the board. The current feedback signal sends messages 

to the MCU AD input pin directly.  

Data 

Power source PWM (kHz) Input power (W) Phase current (Arms) Pictures  

220 VAC 15 

320 2 Figure 36 

500 3 Figure 37 

930 5.5 Figure 38; Figure 39 

Legend CH1: Vdc; CH3: VAC; CH4: phase current 

Condition ⚫ R15 and R19 on the EVAL-M1-IM523 were removed from the board; then R50 was soldered 

to 0 Ohm resistor. The parameters in MCEWizard were calculated with 3 times the internal 
gain. The current scaling was changed to 8.3 mV/A, ADC offset voltage to 833 mV and gate 

driver delay time to 0.5 s. 

Results ⚫ We ran the board for the 2 A, 3 A, and 5.5 A current load. We checked the Iu & Iv current 

waveforms, which are uniformly sinusoidal.  

⚫ The system is stable. The motor Flx_M is steady (see Figure 40). 
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Figure 36 320 W load current feedback, 2 Arms phase current, 15 kHz PWM, 220 VAC input 
 

 

Figure 37 500 W load current feedback, 3 Arms phase current, 15 kHz PWM, 220 VAC input   
 

 

Figure 38 930 W load, 5.5 Arms phase current, 15 kHz PWM, 220 VAC input  
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Figure 39 Scope waveforms at 930 W load, 5.5 Arms phase current, 15 kHz PWM, 220 VAC input  

 

 

Figure 40 Flx_M & Iu waveform in MCEDesigner  
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5 Acronyms 

Table 11 Abbreviations 

Abbreviation Meaning 

AC Alternating current    

AD Altium designer 

CAP Capacitance 

CCM Continuous conduction mode 

CE Conformité Européenne 

CERA Ceramic 

EMI Electromagnetic interference 

EMC Electromagnetic compatibility 

ESD Electrostatic discharge 

EFT Electrical fast transient 

DC Direct current 

DCBUS Direct current bus voltage 

DCM Discontinuous conduction mode 

DCP Direct current bus voltage positive 

ELCO Electrolytic capacitor 

FILM Film capacitor 

GUI Graphical user interface 

GDT Gas discharge tube 

IC Integrated circuit 

IGBT Insulated gate bipolar translator 

IPM Intelligent power module 

LED Light emitting diode 

MADK Modular application design kit 

MCE Motion control engine 

NTC Negative temperature coefficient 

OCP Overcurrent protection 

PC Personal computer 

PCB Printed circuit board 

PCN Process change notification 

PD Product discontinuation 

PE Protect earth 

PGND Protect ground 

PLL Phase locking loop 

PTC Positive temperature coefficient 

PWM Pulse-width modulation 

RES, R Resistor 
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Abbreviation Meaning 

RMA Returned material analysis 

RoHS Restriction of hazardous substances in electrical and electronic equipment 

SGND Secondary ground 

SOI Silicon-on-insulator 

UART Universal asynchronous receiver/transmitter 

USB Universal serial bus 

UVW U phase/V phase/W phase 

VCC Voltage circuit 
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